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Abstract - Scan systems using unmanned aircraft or drone are designed to be able 

predicted when there is radiation exposure from radioactive sources. The drone is 

equipped with a Geiger Muller detector type J305 tube and a GPS (Global Positioning 

System) Tracker and other communication tools. Testing of this system was carried out in 

the field of B.J. Habibie Serpong, National Research and Innovation Agency using a 

radioactive source of Cs-137. The drone's flight direction has been designed at the Red 

Waypoint and has a height of 2 meters. Radiation detection mapping was carried out using 

Quantum GIS (Geographic Information System) software. The classification parameter in 

Quantum GIS is divided into 3 parts, namely the first class value is 0.00 to 0.10, the second 

class is 0.11 to 0.20, and the third class is 0.21 to 0.40. In this study, there are 5 coordinates 

of the highest radiation value with a red round symbol. These points indicate radiation 

levels of 0.24, 0.24, 0.24, 0.36, and 0.28. Using identification feature, the mapping results 

can help the user in analyzing and enable quickly find areas with high radiation. Thus, the 

decontamination or transfer of radioactive sources can be used as a quick and appropriate 

follow-up. 
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I. Introduction 

 Radiation detection using drones can 

contribute significantly, especially to 

environmental radiation monitoring for safety 

and security and can display infographics of 

radiation monitoring results. Today's use of 

drone technology is developing very rapidly, 

drones equipped with cameras can be used for 

mapping, or even reconnaissance. Drones 

equipped with radiation detection and 

measurement equipment can be used to scan 

and map areas and locations suspected of 

having radioactive sources, or being 

contaminated with radioactive substances. 

Therefore, radiation detection systems using 

drones continue to be innovated in processing 

and delivering the results. [1] 

The development of knowledge about 

Geographic Information Systems began in 1967 

by Roger Tomlinson as CGIS (Canadian GIS - 

GIS Canada) at that time. Early in its 

development it was implemented in Ottawa 

Ontario by the Department of Energy, Mines, 

and Resources. Its use at that time was to store, 

identify, and process data collected for the 

Canadian Land Inventory (CLI). CGIS is the 

first system in the world and the result of 

improved mapping applications that have the 

ability to overlay, calculate, digitize/scanning, 

support a national coordinate system that spans 

the American continent, insert lines as arcs that 

have a topology and store attributes and 

locational information in separate files. 

Therefore, Roger Tomlinson is called the 

"Father of GIS". [2]   

Analysis of geographic information 

system data which previously could analyze 

classification, overlay analysis, networking 

analysis, buffering analysis, three-dimensional 
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analysis, then in this research innovation is 

carried out as radiation point analysis. It is 

known that the function of the geographic 

information system in previous studies was 

used as an inventory of natural resources, 

development planning, spatial planning, 

transportation planning, and disaster 

mitigation. Currently, the geographic 

information system also serves as an 

identification of the value of the radiation level. 

In its application, the geographic information 

system also supports disaster mitigation that 

has the potential to occur when exposure to 

radioactive sources occurs, thereby 

contaminating the environment. Mapping using 

Quantum GIS is known to be the area of the 

contaminated area so that it can quickly identify 

priority areas or points for handling high 

radiation hazards. [3] The level of public health 

is also taken into account as a cause and effect 

caused by the high radiation hazard in the 

environment. 

 Geographic information system 

components are hardware, software, data, user 

or brainware, and methods. [2] The hardware 

used in the radiation detection mapping system 

uses a drone or unmanned aircraft equipped 

with a GPS (Global Positioning System) sensor 

and a Geiger Muller radiation detector type 

J305 tube. The software used is Quantum GIS 

(Geographic Information System) software. 

Brainware or users are operators who are in 

charge of radiation monitoring using drones to 

carry out the mapping stages on the software. 

And the method used is by testing the operation 

of the radiation monitoring system using 

drones, starting with the design of the 

monitoring path, sending data, receiving data, 

processing data, to identifying radiation value 

points that are classified as high or dangerous. 

In this study, it is hoped that the mapping of 

radiation detection system information using 

Quantum GIS can build a system that is able to 

store data, manage, and display the results of 

radiation level monitoring in the form of a 

visual display. 

 

 

 

II. Research Method 

Monitoring the level of radiation that 

moves within a certain area by utilizing drone 

technology. The drone used is the DJI Inspire 2 

with the ability to fly at 50 mph or as far as 80 

kph in 5 seconds and with a maximum speed of 

58 mph or 94 kph. Equipped with two batteries, 

this drone can operate for 27 minutes. As well 

as having the ability to avoid obstacles in two 

directions and sensor redundancy. [4] Figure 2. 

shows the drone device used in the radiation 

level monitoring system. 

 
(a)      (b) 

Fig 1. DJI Inspire 2 (a) Remote Control Drone (b) 

The isotope used in this research is Cs-

137 with 100mCi activity on 01-01-1992. The 

isotope Cs-137 has a long half-life of 30.13 

years. On the other hand, in the field of 

construction of petroleum industrial 

installations, the isotope Cs-137 is used in 

testing the quality of welds during the 

installation of oil/gas pipelines and oil refinery 

installations. Radiographic techniques are often 

used in the construction stages and this 

technique is also used in testing the weld quality 

of high pressure steam boilers as well as testing 

for hardness and cracks in concrete 

construction. [5] This isotope is placed in the 

field for the drone to cross directly above it at a 

certain height and speed. 

Geographic Information System is an 

information system that is used to input, store, 

process, analyze, and produce referenced or 

geospatial data to support decision making. [6] 

Digitization in Quantum GIS that can be done 

is the technique of digitizing maps or mapping. 

In principle, map creation is processed and the 

mapping results file is stored using a computer. 

Mapping results are grouped according to 

layers according to their respective types. In the 

mapping process, 3 types of layers are used, 

namely, polygon types, point types, and line 
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types. In each process, add attributes as needed 

that will be displayed as information. [7] 

Quantum GIS is the Open Source tool 

chosen to be used in this test. Quantum GIS or 

Quantum Geographic Information System 

which was formed in 2002 was built using the 

QT toolkit and C++. Quantum GIS is capable 

of displaying a GUI or Graphical User 

Interface. Quantum GIS is easy to operate and 

comes with various functions and features. 

Quantum GIS can also be used as data 

visualization, data analysis, presentation of 

fund maps or atlases. [8] Quantum GIS 

software functions as a geographic information 

system that contains supporting programs such 

as data input, data processing, and data output. 

[3] 
 

 
Fig 2.  Quantum GIS Software 3.22 

Research on drone radiation detection 

systems goes through several stages as follows: 

1. Determine the location that is suspected 

to be contaminated or there is a 

radioactive source. 

a. In this study, the source is 

placed in the middle of the field 

in the science and technology 

area of B.J. Habibie Serpong, 

National Research and 

Innovation Agency. 

b. In future research, drones can be 

flown in affected areas. 

2. Prepare a drone test equipment that is 

equipped with a detector. 

a. Checking the battery availability 

on the drone and connectivity to 

the software used for operation. 

b. Make sure the software is pre-

installed. The software used is 

Red Waypoint. 

 

Fig 3.  Red Waypoint Software 

3. Prepare the data receiving device 

operated by the monitoring operator. 

4. Designing the radiation detection path 

to be traversed by the drone. 

a. Determine the speed of the 

drone. 

b. Drones with a speed of more 

than 5 Km/h will be difficult to 

do data sampling. The 

information obtained is not 

optimal. 

c. Set the drone's flying height 

limit of 2 meters. 

5. Adjusting to the geographical 

conditions of the environment at the 

time of testing. 

The flow diagram of the radiation 

monitoring process using drones is as follows: 

 

Fig 4. Drone Detection System Mapping Flowchart 

Using Quantum GIS 
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Quantum GIS can display radiation 

level points in the test area. The radiation 

monitoring test results processed using 

Quantum GIS can be identified in detail with 

radiation parameters adjusted to several 

classifications so that it is easy to find low 

radiation levels to the highest radiation levels in 

one test data. Classification can be adjusted to 

the data that will be used from field test results. 

The range of classification values can be 

adjusted according to the needs of the display 

output results. This range of values can be 

divided into two or more classifications of 

radiation levels. This is expected to make it 

easier for operators to read radiation monitoring 

data based on the classifications that have been 

made. 

 

III. Result and Discussion 

 Quantum GIS operation is carried out in 

the following steps: 

1. Install the latest version of Quantum 

GIS or Quantum GIS 3.22 on the laptop. 

2. Operation begins by opening the 

Quantum GIS software. 

 

Fig 5. Quantum GIS Has Been Installed On 

The Device 

3. Choose Menu Option: Layer > Add 

Layer > Add Delimited Text Layer. 

 

Fig 6. Adding Layers to Quantum GIS 

4. Fill in the Data Source Manager on 

Delimited Text. Select the delimited 

text and continue by filling in the 

information on the required parameters. 

 

Fig 7. Data Source Manager in Quantum GIS 

5. Select a file containing test result data in 

.CSV or Comma Separated Value file 

format. 

 
Fig 8. Select the Test Result File in Quantum 

GIS 

6. Adjust the file format with the selected 

file format. And fill Geometry 

Definition as follows: 

Table 1. Geometry parameter 

Geometry 

Definition 
Parameters 

Point 

coordinates 
Selected 

X field longitude 

Y field latitude 

Geometry 

CRS 

EPSG:4326 – 

WGS 84 
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Fig 9. File Format and Geometry Definition in 

Quantum GIS 

7. Choose Menu Option: Web > 

QuickMapServices > OSM > OSM 

Standart. 

 
Fig 10. Displaying Standard OSM in Quantum 

GIS 

8. Quantum GIS displays the coordinates 

of the radiation monitoring results in the 

previous test. 

 
Fig 11. Displaying Radiation Detection 

Coordinates in Quantum GIS 

9. Select Properties on the layer that has 

been successfully displayed. 

 
Fig 12. Properties Settings 

10. Change the Symbology parameter on 

the layer file. 

 
Fig 13. Symbology Parameter Settings 

11. Fill in the Symbology parameters as 

follows: 

Value selected 1.2 radiation and   

clicked three times as a range or class of 

radiation levels. 

Each class adjusts the filling of the 

symbol selector: 
 

Table 2. First symbol selector parameter 

Symbol 

Selector 
Parameters 

Class First Class 

Color Green 

Symbol round 

Opacity 100% 

Size 2 Milimeters 

Rotation 0 

 
Table 3. Second symbol selector parameter 

Symbol 

Selector 
Parameters 

Class Second Class 

Color Yellow 

Symbol round 

Opacity 100% 

Size 2 Milimeters 

Rotation 0 

 
Table 4. Third symbol selector parameter 

Symbol 

Selector 
Parameters 

Class Third Class 

Color Red 

Symbol round 

Opacity 100% 

Size 2 Milimeters 

Rotation 0 
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Fig 14. Symbology Parameter Settings 

 
Fig 15. Radiation Level Classification Setting 

12. Enter the value of each class using the 

parameters shown by table 5,6, and 7. 

 

Table 5. First class bounds parameter 

Class Bounds Parameters 

Class First Class 

Lower value 0.00 

Upper value 0.10 

 

Table 6. Second class bounds parameter 

Class Bounds Parameters 

Class Second Class 

Lower value 0.11 

Upper value 0.20 

 

Table 7. Third class bounds parameter 

Class Bounds Parameters 

Class Third Class 

Lower value 0.21 

Upper value 0.4 

 

 

 
Fig 16. Radiation Level Classification Setting 

13. After the class has been created, 

continue by clicking Apply to display 

the results of parameter settings in 

properties. 

 
Fig 17. Saving Symbology Parameter Settings 

14. Quantum GIS displays the results of the 

coordinates according to the radiation 

level class that has been determined in 

the previous step. 

 
Fig 18. Mapping Results 

15.  Choose Menu Option: View > Identify 

Features. 

 
Fig 19. Identifying Mapping Results 
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16.  Radiation point identification 

information with red class is shown on 

the right side of the screen. 

 
Fig 20. Display of the Mapping Result 

Identification Feature 

 From reading the GUI display and 

supported by identify features, the results of the 

red class radiation level or the highest radiation 

class at the time of testing are as follows: 

 

(a) 

 

(b) 

 

(c) 

 

(d) 

 

(e) 

Fig 21. Radiation level with a value of 0.24(a), 

Radiation level with a value of 0.24(b), Radiation level 

with a value of 0.24(c), Radiation level with a value of 

0.36(d), Radiation level with a value of 0, 28(e) 

The results of the 5 coordinate points in 

Figure 21 can be seen in the table 8: 
 

Table 8. Radiation monitoring results with red 

classification 

Figure Latitude Longitude Radiation 

(a) -6,350013 106,665191 0,24 

(b) -6,350018 106,665199 0,24 

(c) -6,350223 106,665405 0,24 

(d) -6,350182 106,665481 0,36 

(e) -6,350137 106,665664 0,28 

 

In table 1 it is explained that there are 5 

coordinate points that can be seen in the 

visualization of the radiation level detection 

mapping using drones. The first point (a) with 

coordinates latitude -6.350013 and longitude 

106.665191 radiation level 0.24. The second 

point (b) with coordinates latitude -6.350018 

longitude 106.665199 radiation level 0.24. The 

third point (c) with coordinates latitude -

6.350223 longitude 106.665405 radiation level 

0.24. The fourth point (d) with coordinates 

latitude -6.350182 longitude 106.665481 

radiation level 0.36. And lastly, the fifth point 
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(e) with coordinates latitude -6.350137 

longitude 106.665664 radiation level 0.28. The 

data shows that the five coordinate points are in 

the class with a red round symbol.  
 

IV. Conclusion 

Quantum GIS supports the 

implementation of visual radiation monitoring 

results. The operating method and class 

determination can be adjusted to the subsequent 

test results data when filling in the symbology 

parameters in classes parameters. The results of 

this research show the identification of 

radiation value points that are classified as high 

or dangerous using Quantum GIS software. 

This research data uses three ranges of 

classification of radiation values based on 

needs. To show that Quantum GIS can display 

the desired results, a lower value range of 0.21 

and an upper value of 0.4 are created so that 

Quantum GIS is able to display radiation data 

in this classification as many as 5 identified 

data. The radiation level does not show high 

numbers but is included in the red classification 

that has been made. These data are radiation 

levels of 0.24, 0.28, and 0.36 as pilot data for 

high radiation levels in the tests carried out in 

this research. This is to prove and facilitate data 

analysis of the results of radiation monitoring 

tests using drones that have been carried out. 
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